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Supported Papers
A large amount of information is stored in your printer as printable pages. The following pages are 
samples of the printable page for this topic. 

All the printable pages have this format, with color bars at the top and at the bottom of the page. Print 
these pages at the printer�s front panel. 

Accessing printable pages

Access these pages from the Printable Pages Menu:

1. At the front panel, scroll to the Printable Pages Menu using the Down Arrow or 
Up Arrow key and press the OK key.

2. Scroll to the desired printable page (such as Paper Tips) using the Down Arrow or Up Arrow 
key and press the OK key.

Menu Map

For a complete list of printable pages, print the Menu Map:

1. Select Menus on the front panel and press the OK key.

2. Select Print Menu Map and press the OK key.

7300-58



Page 1 of 2

Paper Type

Light Paper

Plain Paper

Medium Paper

Transparency

Thin Card Stock

Thick Card Stock

Envelope

You can also use custom envelope sizes.

Labels

Glossy Coated Paper

Business Cards

Greeting Cards

CD/DVD Labels and CD/DVD Inserts

64 - 75 g/m   (17 - 20 lb Bond)

75 - 90 g/m  (20 - 24 lb Bond)

120 - 163 g/m   (44 - 60 lb Cover)

163 - 203 g/m   (60 - 75 lb Cover)

120 - 163 g/m   (81 - 110 lb Book)

64 - 120 g/m   (17 - 32 lb Bond)
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#10 Commercial Envelope (4.12 x 9.5 in.)
Monarch Envelope (3.87 x 7.5 in.)
A7 Envelope (5.25 x 7.25 in.)
Custom

DL Envelope (110 x 220 mm)
C4 Envelope (229 x 324 mm)
C5 Envelope (162 x 229 mm)
C6 Envelope (114 x 162 mm)
B5 Envelope (176 x 250 mm)

Tray

Tray 1

All Trays

Tray 1

MPT

MPT

Medium Heavy Paper
90 - 105 g/m  (24 - 28 lb Bond) Tray 1

MPT

Heavy Paper
105 - 120 g/m  (28 - 32 lb Bond) Tray 1

MPT

MPT

MPT

MPT

MPT

MPT

Tray 1

All Trays

Special Only one special setting at a time may be selected.

MPT

MPT

Tray 1

MPT
All Trays

MPT

MPT

MPT

The Multi-Purpose Tray (MPT) and other trays use only certain sizes and types of paper or transparencies. Follow these tables to ensure the best print 
quality and to avoid paper jams. For best results, use only Xerox Phaser   branded media as it is guaranteed to produce excellent results on your Phaser 

7300 Printer - the Phaser    7300 and Phaser   media are Made for Each Other.  

Caution: Use only paper envelopes. Do not use envelopes �
with windows or metal clasps.

Caution: Do not print on label stock once labels have been removed.

Caution: Do not use glossy ink-jet paper or non-laser glossy paper as they 
may cause damage to the printer's fuser.

Caution: Do not print business card media once cards have been removed.

Caution: Do not print label or insert media once labels or inserts have    
been removed.

Caution: Use only Phaser    35-Series Transparency Film. �
Other transparencies may damage the printer's fuser.  

Caution: Damage caused by using unsupported �
media is not covered by your printer's warranty.
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64 - 120 g/m   (17 - 32 lb Bond)
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* Tray 1 only

PHASER® 7300 COLOR PRINTER
Paper Tips

105 g/m2   



Part Number

016-1368-00
016-1369-00
016-1699-00

016-1700-00

016-1900-00

016-1901-00

016-1894-00

016-1895-00

016-1896-00

016-1897-00

016-1823-00
016-1824-00

016-1812-00
016-1814-00
016-1813-00
016-1815-00

016-1704-00

016-1705-00

016-1718-00

016-1719-00

016-1940-00

016-1941-00

016-1898-00
016-1899-00

016-1987-00

016-1988-00

016-2011-00

016-2026-00

Size

Letter
A4
Tabloid

A3

Tabloid Extra

SRA3

Letter

A4

Letter

A4

Letter
A4

Letter
A4
Letter
A4

Letter

A4

Tabloid

A3

Tabloid Extra

SRA3

Letter
A4

Letter

A4

Letter

A4

Paper Type Phaser   Branded Media

Plain Paper

Transparency

Thin Card Stock

Labels

Glossy Coated Paper

Business Cards

Greeting Cards

CD/DVD Labels
CD/DVD Inserts

Paper tips
   •  If excessive jams occur, flip and fan the paper in the tray or install fresh paper �
      from an unopened ream.

   •  Transparencies should be fanned prior to loading.

   •  Other size envelopes may be printed in custom mode. 

   •  Use only paper envelopes. Do not use envelopes with windows or metal clasps.

   •  Label media should be fanned prior to loading.

   •  Do not print on labels once a label has been removed.

Page 2 of 2

See www.xerox.com/officeprinting/7300supplies for information on ordering supplies.

Premium Color Printing Paper, 500 Sheets

35-Series Standard Transparency, 50 Sheets

35-Series Premium Transparency, 50 Sheets

Premium Cover Paper, 100 Sheets

Color Printing Labels, 30/Sheet, 100 Sheets
Color Printing Labels, 14/Sheet, 100 Sheets
Color Printing Labels, 6/Sheet, 100 Sheets
Color Printing Labels, 8/Sheet, 100 Sheets

Glossy Coated Paper, 100 Sheets

Glossy Coated Paper, 50 Sheets

Premium Business Cards, 10/Sheet, 25 Sheets

Premium Greeting Cards with Envelopes, 25 Sheets/Envelopes

CD/DVD Labels and Inserts

20 Labels and Inserts

®

http://www.xerox.com/officeprinting/7300supplies
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Trays 
This section covers:

� Loading paper in Trays 1-5 � see page 3.

� Loading paper in the Multi-Purpose Tray � see page 6.

� Using custom size paper � see page 8.

For a list of the acceptable papers, transparencies, envelopes, and labels that can be used in each tray, 
refer to the Supported Papers section of the Trays and Paper Guide on the Interactive Documentation 
CD-ROM.

Note

Do not load a tray that is currently being used for printing.

Caution

Instructional videos for loading trays are available on the Interactive Documentation 
CD-ROM or the Xerox web site at: www.xerox.com/officeprinting/7300support

You can also refer to the labels inside the printer for paper loading instructions.

You MUST set the paper type and size in the 
printer�s front panel any time you add paper to 
the printer. If you change paper sizes or types, 
take moment to ensure that the front panel 
values agree with your paper choice. If you 
fail to do this, you can damage the printer�s 
fuser.

OK

6200-46

http://www.xerox.com/officeprinting/7300support
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Loading paper in Trays 1-5 
Note

Note

Transparencies and glossy coated paper cannot be loaded in trays 2-5; they can only be 
loaded in Tray 1 or the Multi-Purpose Tray. Envelopes, labels, business cards, greeting 
cards, thick card stock, CD/DVD labels, and CD/DVD inserts cannot be loaded in trays 1-5; 
they can only be loaded in the Multi-Purpose Tray.

To load paper in Trays 1-5:

1. Pull out the tray. 

2. If necessary, adjust the width and length guides to match the size of the paper. 

If you change the type of paper, you MUST 
specify the type on the front panel of the 
printer.

OK

6200-45

7300-21

7300-23
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3.  Fan the paper to release sheets that are stuck together. 

Note

Observe the fill lines on the back of the tray. Do not load paper or transparencies above the 
paper (1) or transparency (2) fill line, because it may cause a jam.

7300-22

7300-81

MAX

MAX

1

2
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4. Insert a stack of paper into the tray. Depending on the size and type of paper, load the paper 
long-edge feed or short-edge feed. For information on custom size paper, refer to page 8.

5. Slide the tray back into the printer and turn to the front panel.

6. When the front panel prompts you:

� If you haven�t changed the type of paper, press the OK key to accept the current setting for 
paper type.

� If you have changed the type of paper, scroll to the correct paper type and press the OK key 
to save your selection.

Note

To avoid possible print-quality and paper-feed problems, make sure that the tray�s paper type 
setting matches the loaded paper type.

Long-edge feed Short-edge feed

� Use for the following sizes: Letter, A4, and 
B5 JIS.

� Use for transparencies (in Tray 1 only). 
Transparencies should NOT be loaded in 
Trays 2 - 5.

� Place the side to be printed facedown with the top 
of the page at the back of the tray.

� Prepunched holes should be on your right as you 
face the printer.

� Use for the following sizes: Legal, Tabloid 
(11 x 17 in.), Tabloid Extra (12 x 18 in.), 
Executive, US Folio, A3, SRA3, A5, A6, and 
B4 JIS.

� Place the side to be printed facedown with the top 
of the page on your right as you face the printer. 

� Prepunched holes should be towards the front of 
the tray.

7300-38
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6200-45
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Loading paper in the Multi-Purpose Tray
Use the Multi-Purpose Tray for envelopes and specialty papers, such as labels, business cards, greeting 
cards, CD/DVD labels, and CD/DVD inserts as well as paper.

Note

Note

Automatic 2-sided printing is not available with the Multi-Purpose Tray.

To load paper in the Multi-Purpose Tray:

1. Open the Multi-Purpose Tray and unfold the two extensions.   

2. If printing on envelopes or specialty media, open the Left Side Output Tray and swing out the two 
extensions.  

If you change the type of paper, you MUST 
specify the type on the front panel of the 
printer.

OK

6200-46

7300-18

1 2

3

7300-17

2

1
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3. Insert the paper or transparencies in the Multi-Purpose Tray and adjust the width guides to match 
the size of the paper. Depending on the size and type of paper, load the paper long-edge feed or 
short-edge feed. For information on custom size paper, refer to page 11.  

Long-edge feed Short-edge feed

� Use for the following sizes: Letter, A4, B5 JIS, 
and ISO B5 (except for labels, business cards, 
greeting cards, CD/DVD labels, and CD/DVD 
inserts).

� Use for transparencies.
� Place the side to be printed faceup.
� Prepunched holes should enter the printer first.

� Use for all sizes except Letter, A4, B5 JIS, and 
ISO B5 of most paper types.

� Use for all sizes of labels, business cards, greeting 
cards, CD/DVD labels, and CD/DVD inserts.

� Place the side to be printed faceup with the top of 
the page entering the printer first.

� Prepunched holes should be towards the front of 
the printer.

 

7300-71

7300-72

7300-74 7300-75

7300-93
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4. When the front panel prompts you and you haven�t changed the type or size of paper, press the 
OK key to accept the current settings for type and size.

5. If you have changed the type or size of paper:

a. On the printer�s front panel, scroll to Change (by pressing the Down Arrow key) and press 
the OK key.

b. Scroll to the correct paper type and press the OK key to save your selection.

c. Scroll to the correct paper size and press the OK key to save your selection.

Using custom size paper
In addition to the wide variety of paper sizes available for this printer, you can use custom size paper. 
Depending on the size, custom size paper can be loaded in Tray 1 or the Multi-Purpose Tray (as 
described on page 11).

Note

After you load a custom size paper in any of this printer�s trays, you MUST set the front 
panel values to agree with the paper you have loaded.

Note

Banner paper (paper over 18 inches (450 mm) long must be loaded into the Multi-Purpose 
Tray. You MUST use the Left Side Output Tray for output. See �Output Trays� on page 26.

Tray 1 Multi-Purpose Tray

X dimension 148 mm - 328 mm
5.83 in. - 12.60 in.

105 mm - 328 mm
4.13 in. - 12.60 in.

Y dimension 148 mm - 457 mm
5.83 in. - 18 in.

148 mm - 914 mm
5.83 in. - 36 in.

OK

6200-45
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Loading custom size paper in Tray 1
1. Open the tray, as described on page 3.

2. Insert the custom size paper and adjust the guides to match the size of the paper. Place the side to 
be printed facedown. 

3. When the front panel prompts you to confirm the type of paper, scroll to the correct paper type and 
press the OK key to save your selection.

4. Set the tray for custom size paper and specify the dimensions:

a. On the front panel, with Menus highlighted, press the OK key.

b. Scroll to Printer Setup Menu (by pressing the Down Arrow key) and press the 
OK key.

c. Scroll to Tray Setup Menu and press the OK key.

d. Scroll to Tray # Setup Menu (where # is the number of the tray) and press the OK key.

e. If you don�t see a selection for Set Custom X, scroll to Custom Size and press the OK 
key to change Custom Size to On.

f. Scroll to Set Custom X and press the OK key.

g. Press the Down Arrow or Up Arrow key to scroll to the value for X (labeled 1 in the 
illustration in Step 2) and then press the OK key.

h. Scroll to Set Custom Y and press the OK key.

i. Press the Down Arrow or Up Arrow key to scroll to the value for Y (labeled 2 in the 
illustration in Step 2) and then press the OK key.

7300-82

1

2

OK

6200-45
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When you use standard size paper in Tray 1 and adjust the guides for that paper, you don�t need to 
specify the paper size in the front panel. Tray 1 contains size sensors that automatically inform the 
printer about the paper size. However, when you insert custom size paper in the tray and change 
Custom Size to On, the size sensors are turned off and you must enter the X and Y values as 
described in Step 4. If you later insert standard size paper in the tray, you must turn on the tray sensors 
again by changing Custom Size to Off:

1. On the front panel, with Menus highlighted, press the OK key.

2. Scroll to Printer Setup Menu (by pressing the Down Arrow key) and press the OK key.

3. Scroll to Tray Setup Menu and press the OK key.

4. Scroll to Tray # Setup Menu (where # is the number of the tray) and press the OK key.

5. If you see a selection for Set Custom X, scroll to Custom Size and press the OK key to 
change Custom Size to Off. This reactivates the tray sensors for that tray.
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Loading custom size paper in the Multi-Purpose Tray
1. Open the Multi-Purpose Tray, as described on page 6.

2. Insert the custom size paper and adjust the guides to match the size of the paper. Place the side to 
be printed faceup. 

3. If your paper is over 18 inches long, open the left side output tray. See page 26.

4. When the front panel prompts you to confirm the type and size of paper:

a. Scroll to Change (by pressing the Down Arrow key) and press the OK key.

b. Scroll to the correct paper type and press the OK key to save your selection.

c. For the paper size, scroll to Custom and press the OK key.

d. Scroll to Set Custom X and press the OK key.

e. Press the Down Arrow or Up Arrow key to scroll to the value for X (labeled 2 in the 
illustration in Step 2) and then press the OK key.

f. Scroll to Set Custom Y and press the OK key.

g. Press the Down Arrow or Up Arrow key to scroll to the value for Y (labeled 1 in the 
illustration in Step 2) and then press the OK key.

PHASER
7300

7300-83

1

2

OK

6200-45
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Specialty Printing
This section covers:

� Automatic 2-sided printing � see page 12.

� Manual 2-sided printing � see page 14.

� Transparencies � see page 19.

� Envelopes � see page 22.

� Labels, Business Cards, Greeting Cards, CD/DVD Inserts, and CD/DVD Labels � 
see page 24.

For a list of the acceptable papers, transparencies, envelopes, and labels that can be used in each tray, 
refer to the Supported Papers section of the Trays and Paper Guide on the Interactive Documentation 
CD-ROM.

Caution

Automatic 2-sided printing
To have the printer do automatic 2-sided printing (duplexing):

� The printer must have a duplex unit installed.

� The paper must be loaded in a tray. The printer will NOT do automatic 2-sided printing on paper 
loaded in the Multi-Purpose Tray.

� The paper must have a weight of 75-105 g/m2 (20 - 28 lb. bond).

� The paper size must be A5 or larger. The printer will NOT do automatic 2-sided printing on paper 
smaller than 148 x 210 mm (5.83 x 8.27 in.).

� The paper type must be Plain Paper, Letterhead, or Special.

Caution

DO NOT use any specialty media (such as glossy coated paper), envelopes, or labels for 
automatic 2-sided printing. Any damage caused by duplexing specialty media may not be 
covered under your printer warranty.

For best results with automatic 2-sided printing, do not use heavy toner coverage on the even-numbered 
pages of your print job.

When you print any job, you can use the printer driver to select the orientation of the images on the 
page: Portrait or Landscape. When you print 2-sided jobs, you also select the binding preference, 
which determines how the pages turn; refer to the table on page 14 for the wording used in the printer 
drivers for binding preference.

You MUST set the paper type and size in the 
printer�s front panel any time you add paper to 
the printer. If you change paper sizes or types, 
take a moment to ensure that the front panel 
values agree with your paper choice. If you fail 
to do this, you can damage the printer�s fuser. 

OK

6200-45
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To do automatic 2-sided printing:

1. Insert a stack of paper into the tray. Depending on the size and type of paper, load the paper 
long-edge feed or short-edge feed. For more information, refer to the Trays section of the 
Trays and Paper Guide on the Interactive Documentation CD-ROM. 

2. In the printer driver: 

� Select the tray containing the paper.

� Select the orientation.

� Select 2-sided printing. Refer to the table on page 14 for instructions and the wording used in 
the printer drivers.

3. Send the job to the printer.

Portrait
Bind on Side Edge
Flip on Long Edge

Portrait
Bind on Top Edge
Flip on Short Edge

Landscape
Bind on Side Edge
Flip on Short Edge

Landscape
Bind on Top Edge
Flip on Long Edge

Long-edge feed Short-edge feed

� Use for the following sizes: Letter, A4, and 
B5 JIS.

� Place the side to be printed with the odd-number 
pages faceup with the top of the page at the back 
of the tray.

� Prepunched holes should be on your left as you 
face the printer.

� Use for the following sizes: Legal, Tabloid 
(11 x 17 in.), Tabloid Extra (12 x 18 in.), 
Executive, US Folio, A3, SRA3, A5, A6, and 
B4 JIS.

� Place the side to be printed with the odd-number 
pages faceup with the top of the page on your 
right as you face the printer. 

� Prepunched holes should be towards the back of 
the printer.
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Manual 2-sided printing
If the printer doesn�t have a duplex unit, you can still have the printer print on both sides of the paper. 
However, you must have the printer print all of the odd-numbered pages first, reinsert the printed pages 
in the tray, then have the printer print the even-numbered pages.

You can use Trays 1 - 5 or the Multi-Purpose Tray for manual 2-sided printing.

Paper specifics

� For the best opacity and feed reliability, use Plain Paper that is 90 g/m2 (24 lb. bond) paper.

� 2-sided printing on specialty paper can shorten the life of printer components.

� For best results, do not use heavy toner coverage on side 1 of a manual 2-sided print. Increase the 
top margin on side 1 to at least 12 mm (0.48 in.).

� Print quality may be degraded on the second side of manual 2-sided prints for weights ranging 
from 105-203 g/m2 (>28-75 lb. bond, 58-112 lb. index).

Setting the printer driver for two-sided printing

Macintosh
LaserWriter 8.6
or 
LaserWriter 8.7

1. From the File menu, select Print, and then select Layout.

2. Select Print on Both Sides.

3. Select a binding preference.

Windows 95,
Windows 98, or
Windows Me

1. From the File menu, select Print.

2. Click the Properties button.

3. On the Setup tab, select Print on 2 Sides.

4. Check or uncheck Bind on Top Edge.

Windows 2000
or
Windows XP

1. From the File menu, select Print.

2. Click the Properties button.

3. On the Layout tab for Print on Both Sides (Duplex), select either 
Flip on Long Edge or Flip on Short Edge.

Windows NT 1. From the File menu, select Print.

2. Click the Properties button.

3. On the Page Setup tab for Print on Both Sides (Duplex Printing), 
select either Long Edge or Short Edge.
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Manual 2-sided printing using Trays 1 - 5

Printing side 1

1. Insert a stack of paper into the tray. Depending on the size and type of paper, load the paper 
long-edge feed or short-edge feed. For more information, refer to the Trays section of the 
Trays and Paper Guide on the Interactive Documentation CD-ROM. 

2. In the printer driver, select the tray containing the paper.

3. Send the job to the printer so that the odd-numbered pages (side 1) are printed.

Long-edge feed Short-edge feed

� Use for the following sizes: Letter, A4, and 
B5 JIS.

� Place the side to be printed facedown with the top 
of the page at the back of the tray.

� Prepunched holes should be on your right as you 
face the printer.

� Use for the following sizes: Legal, Tabloid 
(11 x 17 in.), Tabloid Extra (12 x 18 in.), 
Executive, US Folio, A3, SRA3, A5, A6, and 
B4 JIS.

� Place the side to be printed facedown with the top 
of the page on your right as you face the printer. 

� Prepunched holes should be towards the front of 
the printer.
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Printing side 2

1. Insert the paper printed with side 1 into the tray. Depending on the size and type of paper, load the 
paper long-edge feed or short-edge feed.

2. In the printer driver, select the tray containing the paper.

3. Send the job to the printer so that the even-numbered pages (side 2) are printed.

Long-edge feed Short-edge feed

� Place the printed side 1 faceup with the top of the 
page at the back of the tray; (the side to be printed 
is facedown).

� Prepunched holes should be on your left as you 
face the printer.

� Place the printed side 1 faceup with the top of the 
page on your right as you face the printer; (the 
side to be printed is facedown).

� Prepunched holes should be at the back of the 
tray.

7300-44
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Manual 2-sided printing using the Multi-Purpose Tray

Printing side 1

1. Insert a stack of paper into the Multi-Purpose Tray. Depending on the size and type of paper, load 
the paper long-edge feed or short-edge feed. For more information, refer to the Trays section of the 
Trays and Paper Guide on the Interactive Documentation CD-ROM.

2. In the printer driver, select the Multi-Purpose Tray as the paper source.

3. Send the job to the printer so that the odd-numbered pages (side 1) are printed.

Long-edge feed Short-edge feed

� Use for the following sizes: Letter, A4, B5 JIS, 
and ISO B5.

� Place the side to be printed faceup with the top of 
the page at the back of the printer.

� Prepunched holes should enter the printer first.

� Use for all sizes except Letter, A4, B5 JIS, and 
ISO B5 of most paper types.

� Use for labels, business cards, greeting cards, CD/
DVD inserts and CD/DVD labels.

� Place the side to be printed faceup with the top of 
the page entering the printer first.

� Prepunched holes should be towards the front of 
the printer. 

7300-71 7300-72
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Printing side 2

1. Insert the paper printed with side 1 into the Multi-Purpose Tray. Depending on the size and type of 
paper, load the paper long-edge feed or short-edge feed.

2. In the printer driver, select the Multi-Purpose Tray as the paper source.

3. Send the job to the printer so that the even-numbered pages (side 2) are printed.

Long-edge feed Short-edge feed

� Place the printed side 1 facedown with the top of 
the page at the back of the tray; (the side to be 
printed is faceup).

� Prepunched holes should be on your right as you 
face the printer.

� Place the printed side 1 facedown with the top of 
the page entering the printer first; (the side to be 
printed is faceup).

� Prepunched holes should toward the back of the 
printer.
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Transparencies
Transparencies can be printed from Tray 1 or the Multi-Purpose Tray. Handle transparencies by the 
edges and with both hands to avoid fingerprints and creases, which can cause poor print quality. 

Xerox Phaser 35-Series Transparencies

Xerox recommends that you use Phaser 35-Series Transparencies, which have been specifically 
developed for use with this type of printer fuser.

To order supplies and accessories, contact your local reseller or visit the Xerox web site at:
www.xerox.com/officeprinting/7300supplies

Using non-Phaser 35-Series transparency film

The printer features a unique oil-less fuser. Phaser 35-Series Premium Transparency film is designed 
specifically to work with the printer's fuser. If you want to use non-Phaser 35-Series transparency film, 
you must use a film that meets the following specifications:

� Compatible with oil-less fuser systems

� Fusing temperature: 165 degrees C

Transparency film that does not meet these specifications can produce poor image quality, produce a 
jam in the printer, wrap around the fuser rollers and even melt on the fuser rollers. Some non-Phaser 
35-Series transparencies have paper tape on the edge that can separate in the heat of the fuser, leading to 
damage. Using non-Phaser 35-Series transparencies may damage the fuser. Damage caused by using 
non-Phaser 35-Series transparencies might not be covered under the warranty, service agreement, or 
Total Satisfaction Guarantee. 

Note

Xerox and Xerox Phaser transparency films developed for other Xerox printers and copiers 
are not meant to be used with this printer. Using non-Phaser 35-Series transparencies may 
damage the fuser and might not be covered under the warranty.

Videos are available with instructions for loading transparencies. Videos are located on the 
Interactive Documentation CD-ROM and on the Xerox web site at: 
www.xerox.com/officeprinting/7300support 

Xerox Phaser 35-Series Transparency Film

Item Size Description Part Number

Premium A/Letter (U. S.)
8.5 x 11 in.

50 sheets 016-1896-00

Premium A4 (Metric Letter)
210 x 297 mm

50 sheets 016-1897-00

Standard A/Letter (U. S.)
8.5 x 11 in.

50 sheets 016-1894-00

Standard A4 (Metric Letter)
210 x 297 mm

50 sheets 016-1895-00

http://www.xerox.com/officeprinting/7300supplies
http://www.xerox.com/officeprinting/7300support
http://www.xerox.com/officeprinting/7300supplies
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Printing transparencies from Tray 1
1. Insert the transparencies long-edge feed into the tray. For more information, refer to the Trays 

section of the Trays and Paper Guide on the Interactive Documentation CD-ROM. 

2. Do not load transparencies above the transparency fill line (2), because it may cause a jam.

3. When the front panel prompts you to confirm or change the selected paper type:

a. Press the Down Arrow key to scroll to Change, then press the OK key.

b. Scroll to Transparency and press the OK key to save your selection.

4. In the printer driver, either select Tray 1 as the paper source or select Transparencies as the paper 
type.
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Printing transparencies from the Multi-Purpose Tray
1. Insert the transparencies long-edge feed into the Multi-Purpose Tray; (maximum capacity is 

50 sheets). For more information, refer to the Trays section of the Trays and Paper Guide on the 
Interactive Documentation CD-ROM.

2. When the front panel prompts you to confirm or change the selected paper type and size:

a. Press the Down Arrow key to scroll to Change, then press the OK key.

b. Scroll to Transparency and press the OK key to save your selection.

c. Scroll to the correct paper size and press the OK key to save your selection.

3. In the printer driver, either select Multi-Purpose Tray as the paper source or select 
Transparencies as the paper type.

7300-73
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Envelopes
Guidelines for envelope printing

� Envelopes can only be printed from the Multi-Purpose Tray.

� Use only paper envelopes.

� Do not print on the back of the envelope.

� Keep unused envelopes in their packaging to avoid the effects of moisture and dryness, 
which can affect print quality and cause wrinkling.

� Many applications include a tool for creating an envelope document. For example, Microsoft 
Word includes an Envelopes and Labels feature in the Tools menu. Be sure to:

� Select faceup.
� Select the feed method with the image centered.
� Clear Clockwise Rotation.

� Load a maximum of 10 envelopes at a time. This printer is not designed to handle 
high-capacity production envelope printing.

� Envelopes may wrinkle depending on weight and stiffness of the envelope.

Caution

Never use envelopes with windows or metal clasps; they can damage the printer. Damage 
caused by using unsupported envelopes might not be covered by your printer�s warranty.

Printing envelopes
1. Insert the envelopes long-edge feed into the Multi-Purpose Tray. For more information, refer to 

the Trays section of the Trays and Paper Guide on the Interactive Documentation CD-ROM.

Most envelopes C4 envelopes

� Place the side to be printed faceup with the 
envelope flap closed, but not tucked in.

� Have the top of the envelope enter the printer 
first.

� Maximum capacity is 10 sheets

� Place the side to be printed faceup with the 
envelope flap closed and tucked in.

� Have the top of the envelope enter the printer last.
� Maximum capacity is 10 sheets

7300-74 7300-94
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2. When the front panel prompts you to confirm or change the selected paper type and size:

a. Press the Down Arrow key to scroll to Change, then press the OK key.

b. Scroll to Envelopes and press the OK key to save your selection.

c. Scroll to the correct envelope size and press the OK key to save your selection.

3. Open the Left Side Output Tray.

4. In the printer driver, either select Multi-Purpose Tray as the paper source or select Envelopes as 
the paper type.

5. Make a test print from your application to confirm that the orientation of your envelope is correct.

OK

6200-45
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Labels, Business Cards, Greeting Cards, 
CD/DVD Inserts, and CD/DVD Labels
Labels, business cards, greeting cards, CD/DVD inserts, and CD/DVD labels can only be printed from 
the Multi-Purpose Tray. The number of sheets that can be loaded depends on the item.

Refer to the Supplies section of the Support Guide on the Interactive Documentation CD-ROM for 
information on part numbers for ordering these items. To order supplies and accessories, contact your 
local reseller or visit the Xerox web site at: www.xerox.com/officeprinting/7300supplies

Guidelines

� If any of the labels, cards, or inserts on a sheet are missing, do not use that sheet; it may 
damage printer components.

� Keep unused labels, cards, and inserts sealed in their original packaging to avoid moisture 
and dryness problems, which can cause poor print quality.

� Store unused labels, cards, and inserts flat in their containers.

� Rotate stock frequently. Long periods of storage can cause the labels, cards, and inserts to 
curl and jam the printer.

� Use the Multi-Purpose Tray for 2-sided printing of labels, cards, and inserts. See �Manual 2-
sided printing� on page 14.

Printing labels, business cards, greeting cards, CD/DVD inserts, and CD/
DVD labels

1. If printing on labels and your application has a setting for labels, use it as a template. Templates 
for greeting cards, etc. are available at the Color Connection web site at: 
www.colorconnection.xerox.com

Item Maximum number of sheets

Labels 50

Business cards 25

Greeting cards 25

CD/DVD labels 50

CD/DVD inserts 25

http://www.xerox.com/officeprinting/7300supplies
http://www.xerox.com/officeprinting/7300supplies
http://www.colorconnection.xerox.com
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2. Insert the sheets short-edge feed into the Multi-Purpose Tray. Place the side to be printed faceup 
with the top of the sheet entering the printer first. For more information, refer to the Trays section 
of the Trays and Paper Guide on the Interactive Documentation CD-ROM.

3. When the front panel prompts you to confirm or change the selected paper type and size:

a. Press the Down Arrow key to scroll to Change, then press the OK key.

b. Scroll to the correct type and press the OK key to save your selection.

c. Scroll to the correct size and press the OK key to save your selection.

4. Open the Left Side Output Tray.

5. In the printer driver, either select Multi-Purpose Tray as the paper source or select the paper type.

7300-75
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Output Trays
You can send output to the following trays:

To change the default output destination on the front panel:

1. With Menus highlighted, press the OK key.

2. Scroll to Printer Setup Menu using the Up Arrow or Down Arrow key.

3. Press the OK key. 

4. Scroll to Job Defaults Menu and press the OK key.

5. Select Set Paper Destination and press the OK key. 

6. Select either Top Output Tray or Left Side Output Tray and press the OK key.

The output goes to the default tray unless specifically changed in the printer driver.

Note

When you select the Left Side Output Tray as the paper destination and the Left Side Output 
Tray is not open, the printer displays an error message on the front panel that the job will not 
print until the Left Side Output Tray is opened.

Top Output Tray
� Default output destination.
� Delivers output facedown.
� Can be used for paper up to 18 inches (450 mm)  

long.

Left Side Output Tray
� Delivers output faceup.
� Keeps the paper flat so is always used for printing on 

envelopes, labels, business cards, and other specialty 
media.

� Must be used when you print on paper that is over 
18 inches (450 mm) long.

7300-17

2

1



Output Trays

Phaser® 7300 Color Printer 27

Offsetting output
When you send output to the Top Output Tray, you can also select offsetting. Offsetting separates print 
jobs or collated sets of a single job by approximately 24 mm (.8 in.) in the output tray. 

Note

If you send output to the Left Side Output Tray, the printer does not offset the output.
You must have a hard drive to have the printer offset collated sets.

You can switch job offsetting on or off on the front panel:

1. With Menus highlighted, press the OK key.

2. Scroll to Printer Setup Menu using the Up Arrow or Down Arrow key and press OK.

3. Scroll to Job Defaults Menu and press the OK key.

4. Scroll to Job Offset.

5. Select either On or Off by pressing the OK key.

Note

If you change job offsetting in your printer driver, this overrides the front panel setting for 
your print jobs.
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